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1. OVERVIEW  

1.1. 7780ASI-IP2 OVERVIEW 

The 7780ASI-IP2 is a complete hardware based solution for encapsulating two MPEG-2 transport 
streams into IP.  As more providers are trying to deliver contribution and distribution quality video over 
IP networks, the 7780ASI-IP2 is capable of bridging traditional compressed world (ASI) with the 
standard IP networks. 
 
Controlled by the industry leading VistaLINK® PRO, the 7780ASI-IP2 offers signal providers the 
capability to encapsulate two MPEG-2 transport stream payload to a unicast or multicast standardized 
IP stream. For contribution application, the 7780ASI-IP2 offers industry standard FEC encoding to allow 
data recovery on the de-encapsulation side. The 7780ASI-IP2 offers input monitoring for detecting 
problems prior to the encapsulator. The 7780ASI-IP2 MPEG over IP encapsulator can be paired to the 
7780IP-ASI2 De-encapsulator for an end-to-end solution. 
 
The 7780ASI-IP2 occupies two card slots and can be housed in a 1RU frame which will hold up to 
three modules, a 3RU frame which will hold up to 7 modules or a standalone enclosure. 
 

• Fully integrated with the Industry leading Evertz VistaLINK® PRO NMS system 
• 2 ASI inputs and 2 IP outputs 
• Bitrate measurement and basic error on both ASI inputs 
• Passive loop through on ASI inputs 
• IP output encapsulated over GigaE RJ 45 for up to 2 TS on ASI inputs 
• Optional FEC encoding- Pro MPEG forum code of practice #3- release 2<cop3> 
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Figure 1-1: 7780ASI-IP2 Block Diagram 
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1.2. 7780IP-ASI2 OVERVIEW 

The 7780IP-ASI2 is a complete hardware based solution for de-encapsulating MPEG-2 transport 
streams from IP to ASI. As more providers are trying to deliver contribution and distribution quality 
video over IP networks, the 7780IP-ASI2 is capable of bridging traditional compressed world (ASI) with 
the standard IP networks. 
 
Controlled by the industry leading VistaLINK® PRO, the 7780IP-ASI2 offers signal providers the 
capability to de-encapsulate two IP streams carrying MPEG-2 transport stream payload to standardized 
ASI streams. For contribution application the 7780IP-ASI2 offers industry standard FEC decoding to 
allow data recovery in case of transmission problems in the IP cloud. It offers real time FEC statistics 
for IP link quality monitoring. The 7780IP-ASI2 offers basic MPEG-2 TS input monitoring for detecting 
problems prior to the de-encapsulator. The 7780IP-ASI2 MPEG over IP de-encapsulator can be paired 
with the 7780ASI-IP2 encapsulator for an end-to-end solution. 
 
The 7780IP-ASI2 occupies two card slots and can be housed in a 1RU frame which will hold up to 
three modules, a 3RU frame which will hold up to 7 modules or a standalone enclosure. 
 
7780IP-ASI2 Features 

• Fully integrated with the Industry leading Evertz VistaLINK® PRO NMS system 
• 2 IP inputs and 4 ASI outputs 
• Bitrate measurement and basic monitoring on MPEG-2 streams 
• Subscription to desired multicast using IGMP- V2/V3 
• De-encapsulation of MPEG-2 TS to 2 separate ASI outputs 
• Optional FEC decoding- Pro MPEG forum code of practice #3- release 2<cop3> 
• Complete customization of status view and error report in VistaLINK® PRO 
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Figure 1-2: 7780IP-ASI Block Diagram 
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2. INSTALLATION 

To successfully install the 7780ASI-IP2 or 7780IP-ASI2, you will require the following items: 
 

1. Unused IP address on the network or a DHCP server 
2. Evertz serial cable 
3. VLPro Server IP address 

 

2.1. HARDWARE INSTALLATION 

Before handling the card it is important to minimize the potential effects of static electricity. It is 
therefore recommended that an ESD strap be worn. 
 
Locate on a 7700 chassis two adjacent vacant slots. Unpack the card and separate the rear card from 
the main card. Locate on the rear of the rack the two slots and remove the blanking panels. Insert the 
rear card into the back of the chassis and secure using the four screws provided. 
 

     
Figure 2-1: 7700 Chassis Rear Panel 
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Figure 2-2: 7780ASI-IP2 and 7780IP-ASI2 Rear Plates 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided. 
Now insert the card into the corresponding front slots ensuring the card lines up with the slot runners on 
the bottom and the top of the chassis. Push the card firmly into the slot ensuring that when it mates 
with the rear plate that is has been securely pushed into a seated position. This can be confirmed when 
the connectivity lights for the Ethernet port are illuminated. Do not connect any cables to the rear card 
until the initial configuration has been completed (failure to do this could cause unwanted network 
issues). 
 

 
Figure 2-3: 7700 Frame Controller 
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Figure 2-4: COM Port Properties Window 

 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
 

 

 
 

 
 

Click OK to apply these settings and press the enter button on your keyboard. The card Main Menu 
should appear as shown in Figure 2-6:  
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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Figure 2-5: 7780ASI-IP2 HyperTerminal Main Menu 
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Figure 2-6: 7780IP-ASI2 HyperTerminal Main Menu 

 
(1) Control Network Configuration 
This sub-menu enables the user to configure the control network settings.  Th Configuring this sub-
menu allows the user to access the card through the VLPro Client interface. 
 
(2) Data Network Configuration 
This sub-menu enables the user to configure the data port network settings.  This setup can 
alternatively be completed from VLPro once the control network settings have been established. 
 
(3) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community 
strings. 
 
(4) Debug Interface 
This menu is for Evertz personnel only. You may be requested to access and execute options within 
this menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before is it possible to configure the card via VLPro it is first necessary to configure the initial basic 
network settings via the serial cable.  Refer to section 2.2. 
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2.2. CONFIGURING THE BASIC NETWORK SETTINGS 

From the terminal session window select option (1) Control Network Configuration, the Control Network 
Configuration menu will be displayed as shown in Figure 2-7. 

1. Select option (1) Set IP Address and configure the card IP address, ensuring that the IP 
address is not already in use on the network.  

2. Select option (2) Set Netmask and configure the correct subnet mask for your network.  
3. If required also configure option (3) Set Gateway.  
4. Exit the Network Configuration menu using (s) Save and Exit, NOT (x) Exit. 

 

 
Figure 2-7: 7780ASI-IP2 Network Configuration Sub-Menu 
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Figure 2-8: 7780IP-ASI2 Network Configuration Sub-Menu 

 
You have now completed the necessary minimum configuration and can connect the cables to the rear 
card when ready. 
 

2.3. CONNECTING TO VLPRO 

This chapter assumes that the VLPro server and VLPro client are already configured for your network 
and you have basic knowledge of the VLPro interface. It also assumes that the user or network 
administrator has already added the appropriate jar file (either for the 7780ASI-IP2 or 7780IP-ASI2) to 
the server, and both the client and server applications have been restarted.  Please refer to the 
VistaLINK® manual for instruction on how to load a jar file.  If you are the network administrator refer to 
section 6.1 for information on updating the VLPro Server Jar File. 
 
Open VLPro and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” button. 
Your card should appear as a newly listed device with the IP address used to configure the card in Step 
1 above. It may take up to a minute to appear while the card and switch negotiate network settings (this 
can be verified directly on the switch if necessary). 
 
As shown in Figure 2-10, the card will list two inputs (numbered one and two).  
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Figure 2-9: 7780ASI-IP2 VistaLINK® PRO Hardware Configuration 

 
Figure 2-10: 7780IP-ASI2 VistaLINK® PRO Hardware Configuration 
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Note: If after a couple of minutes the card has still not appeared, try selecting 
Add Agent from the Tree> Add/Update Agent menu. Enter the IP address used 
in the configuration stage earlier and select OK.  The card should now be listed 
and will remain greyed out for a moment while VLPro finds the card and 
confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VLPro, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical support. 
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3. SPECIFICATIONS 

3.1. 7780ASI-IP2 TECHNICAL DESCRIPTION 

3.1.1. Inputs and Outputs 

• 2xASI input per DVB TR 101 891 270Mb/s (2 loop through) 
• Min ASI TS input bitrate 100kb/s 
• Max ASI TS input bitrate 213Mb/s 
• 2xRJ45 10/100/1000 GigaE output for MPEG over IP 
• 1xRJ45 10/100 control port 
• 1xDB25 Output relay (8 GPO) 

 

3.1.2. Encapsulation Parameters 

• IP encapsulation for each ASI input: 
• MAC 802.3>IPV4>RTP>UDP>MPEG (RTP can be turned on and off) 
• Select 1 to 7 MPEG packets per IP frame 

• Optional FEC encoding (Pro MPEG forum code of practice #3- release 2<cop3>) with L&D 
following the below mentioned range: 

L*D ≤100 
1 ≤ L ≤ 20 
4 ≤ D ≤ 20 

• IP address (IP, Subnet mask, Gateway) for the source 
• IP address for the destination (Unicast and Multicast) 
• Selection of the source port and destination port 
• Set Local MAC address of the equipment 

 

3.1.3. Monitored Parameters 

• Input Status 
• Ethernet and ASI Port Status 
• Ethernet and ASI TS Bitrate 
• Useful Bitrate 
• Null Packet Bitrate 
• TS Sync Loss 
• Continuity Count Error 
• TS Input Packet Size 
• PID List 

 

3.2. 7780IP-ASI2 TECHNICAL SPECIFICATIONS 

3.2.1. Inputs and Outputs 

• 2xRJ45 10/100/1000 GigaE input for MPEG over IP 
• 4xASI outputs per DVB TR 101 891-270Mb/s 
• Min ASI TS output bitrate 100kb/s 
• Max total ASI TS output bitrate 213Mb/s 
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• 1xRJ45 10/100 control port 
• 1xDB25 Output relay (8 GPO) 

3.2.2. De-encapsulation Parameters 

• De-encapsulation of MPEG-2 packets following: 
• MAC 802.3>IPV4>(RTP)>UDP>MPEG 

• Accept 1 to 7 MPEG packets per IP frame 
• Optional FEC decoding (Pro MPEG forum code of practice #3- release 2<cop3>) with L&D 

following the below mentioned range: 
L*D ≤100 
1 ≤ L ≤ 20 
4 ≤ D ≤ 20 

• Join Multicast by providing correct messaging using IGMP V2/V3 
• Selection of the UDP ports, IP Addresses 
• Set Local MAC address of the equipment 

 

3.2.3. Basic Included Monitoring IP Input 

• Stream Type 
• Received Ethernet Bandwidth 
• Received IP Packets 
• Received TS Packets 
• Protocol Type 
• TS Packet Size 
• FEC Statistics: 

o FEC Mode 
o FEC Columns 
o FEC Rows 
o Corrected FEC Packets 

Uncorrected FEC Packets 
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4. 7780ASI-IP2 CARD CONFIGURATION 

Right click the IP address of the 7780ASI-IP2 to access the sub-menu, and then select “View 
Configuration”. The configuration page will open enabling the user to toggle the configuration tabs in 
order to configure the parameters of the 7780ASI-IP2. Sections 4.1 to 4.5 provide an explanation of the 
features and functions of the 7780ASI-IP2 card. 
 

4.1. MONITOR TAB 

The Monitor page displays the status of the Ethernet Data ports and the ASI input ports. The Ethernet 
Output Monitor section displays the port’s mode of operation in the Status field and the Total Bit rate 
that is being output. 
 
The ASI Input Monitor section displays the status of the ASI inputs. The status will not change unless 
a valid ASI feed is detected (you may be required to refresh the status or select auto-refresh to view the 
change). Using the auto refresh button can aid troubleshooting of connectivity issues, however, it will 
prevent any configuration changes. The ASI monitoring fields can be reset at any time by clicking on 
the “Clear ASI 1 Stats” button.  
 
There are no user configurable items on this page.  This page is for information purposes only. 
 
 

 
Figure 4-1: Monitor Tab 
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4.2. ACTIVE PID LIST TAB 

The Active Pid List displays the number of Pids active within the applied ASI Transport Stream. The 
user may be required to refresh the status or select auto-refresh to view the changes. 
 

 
Figure 4-2: Active PID List Tab 
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4.3. CONTROL TAB 

The control tab is divided into three sub-sections, which include: ASI Port Control, Ethernet Setup 
(Data Ports) and Trap Destination (Control Port). 
 

 
Figure 4-3: Control Tab 

 

4.3.1. ASI Port Control 
The ASI Port Control allows the user to enable or disable the physical ASI input on the card. 
 

4.3.2. Ethernet Setup (Data Ports) 
The Ethernet Setup (Data Ports) refers to the physical data port of the 7780ASI-IP2 card. An IP 
address and subnet mask must be entered in this section.  Entering these fields establishes a presence 
on the data network.   The broadcast address will automatically calculate based on your Net Mask.   
 
The user has the ability to assign a custom MAC address to the card (Not recommended).   To use a 
custom MAC address, enable the custom MAC address by selecting the enabled button, as shown in 
Figure 4-4. Once enabled is selected enter a new MAC address in the "Custom MAC Address" field.  
Select the Apply button to allow changes to take effect. 
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Figure 4-4: Ethernet Setup (Data Ports) 

 
The speed of the data port can be manually set at any time by selecting the “Speed Mode” drop down 
box, as shown in Figure 4-5, and then selecting the desired port speed.  By default “Speed Mode” is set 
to AUTO NEGOTIATION. Select the apply button to allow changes to take effect. 
 

 
Figure 4-5: Speed Mode Drop Down Menu 

 

4.3.3. Trap Destination (Control Port) 
The Trap Destination (Control Port) window is used to configure the trap destination addresses. The 
user can assign up to five individual trap destination addresses in this section.   
 

4.4. NOTIFICATION 

This tab is divided into two window subsections: 
1. Send Trap allows the user to customize the top-level alarms.   
2. Fault Present is used as a visual status indicator. 
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Figure 4-6: Notification Tab 

 

4.5. OUTPUT STREAM CONFIGURATION 

Click the ‘+’ button next to the 7780ASI-IP2 IP address to expand the tree and access the sub-menus. 
Right click Stream 1 and select the View Configuration option. The right window will display the 
7780ASI-IP2 Stream Configuration page as shown in Figure 4-7.  The 7780ASI-IP2 allows the user to 
configure up to 4 outgoing streams.  Each of the Ethernet Data ports has the ability to output two 
streams simultaneously.   Below is the output stream configuration window.  The description that 
follows applies to all 4 outgoing streams.  
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The Output Stream window is divided into 2 sub-sections: Monitor and Control. 
 

 
Figure 4-7: Output Stream 

 

4.5.1. Monitor Section 
The Monitor sub-section displays the network statistics for the outgoing stream.  Depending on the 
destination IP addresses the Stream Type will be a Multicast or Unicast.  
 
The network statistics can be reset at any time by clicking on the “Clear Stream Stats”.   
 

4.5.2. Control Section  

• Stream Active:  This option allows the user to quickly enable or disable the outgoing Ethernet 
stream.  

 
• Ethernet Output Port:  This field shows which physical data port is being used for streaming 

data.  
 

• ASI Input Port:  This field allows the user to select the source of the ASI stream.  The user will 
select either input 1 or 2.  
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• Sources IP Address:  This field enables the user to enter the source IP address.  This address 
can be the physical IP address of your data port, or any other address that you may want to be 
encapsulated within the IP packets. 

 
• Sources Port Number: This field enables the user to enter the source port number for the IP 

address entered above. 
 

• Destination IP Address:  This field enables the user to enter the unicast or a multicast IP 
address.  Multicast addresses should be in the range of 224.0.0.0 through 239.255.255.255. 

 
• Destination UDP Port:  This field enables the user to enter the destination port number for the 

IP address entered above. 
 

• RTP Protocol: Use this drop down box to enable the use of the RTP.  The use of RTP is 
recommended as it provides services such as time stamping, sequence numbering and delivery 
monitoring, which can be beneficial for real-time delivery systems.  Also this protocol must be 
enabled if the user wishes to use the FEC (Forward Error Correction) mode.  

 
• TOS: This field enables the user to enter the ToS (Type of Service) value, if your network does 

not support ToS, use zero as default. 
 

• TTL: This field enables the user to enter the TTL (Time to Live) value.  Using the multicast IP 
protocol, the TTL value indicates the scope or range in which a packet may be forwarded. By 
convention: 

 
0 is restricted to the same host 
1 is restricted to the same subnet 
32 is restricted to the same site 
64 is restricted to the same region 
128 is restricted to the same continent 
255 is unrestricted 

 
• TS Packet Per Frame:  This field enables the user to enter the number of MPEG packets to be 

encapsulated per IP packet.   The range of MPEG packets per IP packet is from 1 to 7.  Long-
length packets are undesirable due to the excessive impact from losing each IP packet.  Short 
packets cause a high overhead so a value chosen will be a compromise between these two 
factors.   

 
• TS Packets Size: This field enables the user to enter the size of the TS packet.  The size will 

be 204 bytes or 188 bytes.  
 

• FEC (Forward Error Correction) Mode:  This field enables the user to enter the FEC mode to 
be used.  It will be either 1D (1 Dimensional) or 2D (2 Dimensional). 

 
• FEC Column:  This field enables the user to enter the number of packets per column to be 

associated with an FEC packet.  
 

• FEC Row:  This field enables the user to enter the number of packets per row to be associated 
with an FEC packet.   
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• FEC Offset (Annex A): Use this drop down box to enable the use of a non-block aligned FEC 
arrangement, which is an alternative method of generating the FEC packets.   For more 
information on the FEC offset refer to the Pro-MPEG Code of Practice #3 release 2, Annex A. 

 

5. 7780IP-ASI2 CARD CONFIGURATION 

Right click the IP address of the 7780IP-ASI2 to access the sub-menu and then select the “View 
Configuration” option. The configuration page will open; it is from these configuration tabs that the 
7780IP-ASI2 can be configured. Refer to the relevant section of this manual for an explanation of the 
features and functions. 
 
5.1. MONITOR TAB 

The Monitor page displays the status of the Ethernet Data ports and the ASI output ports. The Ethernet 
Input Monitor section displays the port’s mode of operation in the Status field and the Total Bit rate 
that is being input. 
 
The ASI Output Monitor section displays the status of the ASI outputs. The status will not change 
unless a valid ASI feed is detected.  The user may have to refresh the status or select auto-refresh to 
view the updated changes. Using the auto refresh button can aid troubleshooting of connectivity issues, 
however, it will prevent any configuration changes.  
 
There are no user configurable items on this page.  This page is for information purposes only. 
 

 
Figure 5-1: VistaLINK® PRO – Monitor Tab 
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5.2. CONTROL TAB 

The Control tab is divided into three sub-sections: ASI Port Control, Ethernet Setup (Data Ports) and 
Trap Destination (Control Port). 
 

 
Figure 5-2: VistaLINK® PRO – Control Tab 

 

5.2.1. ASI Port Control  
Allows the user to direct any of the 2 incoming bit streams to any of the output ASI ports. 
 

5.2.2. Ethernet Setup (Data Ports) 
The Ethernet Setup (Data Ports) sub-section refers to the physical data port of the 7780IP-ASI2 card. 
An IP address and Subnet mask must be entered in this section.  This establishes a presence on the 
data network.   The broadcast address will automatically be calculated based on your Net Mask.   
 
The user has the ability to assign a custom MAC address to the card (Not recommended).   To use a 
custom MAC address, enable the custom MAC address by selecting the enabled button, as shown in 
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Figure 5-3.  Once enabled is selected enter a new MAC address in the "Custom MAC Address" field.  
Select the apply button to allow changes to take effect. 
 

 
Figure 5-3: Ethernet Setup (Data Ports) 

 
The speed of the data port can be manually set at any time by selecting the “Speed Mode” drop down 
box, as shown in Figure 5-4, and selecting the desired port speed.  By default “Speed Mode” is set to 
AUTO NEGOTIATION. Select the apply button to allow changes to take effect. 
 

 
Figure 5-4: Speed Mode Drop Down Menu 

 

5.2.3. Trap Destination (Control Port) 
The Trap Destination (Control Port) sub-section is used to configure the trap destination addresses. Up 
to five individual trap destination addresses can be assigned. 
 

5.3. NOTIFICATION  

The Notification tab is divided into two sub-sections: 
1. Send Trap allows the user to customize the top-level alarms.   
2. Fault Present is used as a visual status indicator. 
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Figure 5-5: Notification Tab 

 

5.4. INPUT STREAM CONFIGURATION 

Click the ‘+’ button next to the 7780IP-ASI2 IP address to expand the tree and access the sub-menus. 
Right click the IP Stream 1 option from the Navigation Tree and select the View Configuration option 
from the drop down menu. The right window will display the 7780IP-ASI2 input Stream Configuration 
page as shown in Figure 5-6.  The 7780IP-ASI2 allows the user to capture up to 2 streams.  Each of 
the 4 ASI ports has the ability to output any of the streams simultaneously.   Below is the input stream 
configuration window.  The description that follows applies to both incoming stream configurations. 
 
The Input Stream window is divided into 2 sub-sections: Monitor and Control. 
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Figure 5-6: VistaLINK® PRO Configuration 

 

 
Figure 5-7: Input Stream  
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5.4.1. Monitor Section  

• Stream Type: This field will display whether the card is set to unicast or multicast.  
 
• Received Ethernet Bandwidth: This field will display the current bitrate of the input ASI stream 
 
• Received IP Packets: This field will display the current total number of received IP packets. 
 
• UDP/RTP Protocol: This field will display the protocol setting depending on the incoming packets.  

The options will be either UDP or RTP.  
 
• TS Packet Per Frame: This field will display the number of TS packets within each IP packet. 
 
• TS Packet Size: This field will display the TS packet size.  The values will be either 188 bytes or 

204 bytes.  
 
• FEC Mode: This field will display the FEC mode.  The FEC packet mode will display either FEC 2D 

or FEC 1D. 
 
• FEC Column: This field displays the number of packets per column to be associated with an FEC 

packet. 
 
• FEC Row:  This field displays the number of packets per row to be associated with an FEC packet.   
 
• Number of Corrected FEC Frames: This field will display the number of corrected frames by FEC.  
 
• Number of Uncorrected FEC Frames: This field will display the number of uncorrected frames by 

FEC. 
 
The network statistics can be reset at any time by clicking on the “Clear Stream Stats” button.   
 
5.4.2. Control Section  

• Stream Active: Use this drop box to disable or enable the incoming streams 
 
• Multicast IP address (0.0.0.0 for Unicast):  Enter the destination IP address (This will be the 

multicast address you want the 7780IP-ASI2 to capture). Ensure that you enter the correct IP 
address.  A multicast address should be in the range of 224.0.0.0 through 239.255.255.255. 

 
• Port Number: This field enables the user to enter the destination port number for the IP address 

entered above.  
 
• Ethernet Input Port: Use this drop box to specify which physical data port is to be used to capture 

the IP stream.  
 
• Stream Delay (ms): This field enables the user to set the size of the stream delay.  A larger stream 

delay value will correspond to a larger buffer size. The total delay through the card is equal to the 
decapsulation processing time, plus FEC processing time, plus the stream delay time.  The 
recommended stream delay value is 60 ms.  
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6. TROUBLESHOOTING 

6.1. UPDATING VLPRO SERVER JAR FILE  

Evertz products are constantly evolving and new features are often added. It is therefore important to 
update the JAR files in use to provide access to all the latest features or enhancements. It will also be 
necessary to add JAR files for new products. If your new product has not appeared even after waiting a 
few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file may 
be old or missing. 

 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro Server is restarted). Maximize the VLPro 
Server window from the Windows task bar, select Help> Apply Update> Product from the menu.  

 

 
Figure 6-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 6-2, navigate to the location of the new JAR file and double 
click to select the file. The window will automatically close and the update will be applied in the 
background.  
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Figure 6-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
 

 
NOTE: You may confirm that all updates have been successfully applied by 
selecting from the menu Tools>View>Show/Hide Product update log. 

 
From the menu, shutdown the server by selecting File>Shutdown Server. Now re-open the server, it is 
normal for the startup to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts you will experience a short delay 
while the update is applied. A prompt will appear confirming that the updates have been applied. 
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